EndNote X8 Additional information

EndNote is a referencing management software system that can help you store and organise your references.

Contents

Change the display fields  Page 2
EndNote Ratings  Page 2
Update references, already in your library, with additional online data  Page 3
Add a keyword to multiple references  Page 4
Quick searches  Page 4
Retrieve a Library Summary  Page 4
Creating groups  Page 5
  a) Create a custom group and add references to it  Page 5
  b) Create a smart group  Page 5
  c) Create a group set or combined groups  Page 6
Recently added references  Page 6
Sharing an EndNote library  Page 7
PDF attachments  Page 8
  a) Adding your own annotations  Page 8
  b) View annotations in a list  Page 8
Bibliographies  Page 9
  Create a subject bibliography  Page 9
  Add a formatted list of references to a Word document  Page 10
Cite While You Write – remove field codes  Page 11
Create your own customised style  Page 12
  Step 1) Change folder locations  Page 12
  Step 2) Edit style information  Page 13
  Step 3) Change format for anonymous works  Page 13
  Step 4) Differentiate ambiguous citations  Page 14
  Step 5) Change how multiple authors are output in repeat citations  Page 14
  Step 6) Use bibliography templates  Page 15
  Step 7) Change the layout of the bibliography  Page 15
Import references into EndNote from a text file  Page 16
Import references into EndNote from a reading list  Page 18
Import references into EndNote from Google Scholar  Page 19
Create a compressed backup  Page 19
Create an EndNote Online library  Page 20
Register for EndNote Online via Web of Science  Page 20
Link/Sync EndNote desktop with EndNote Online  Page 20
Access EndNote on an iPad  Page 21
Using EndNote on a Mac  Page 21
Save an EndNote library before leaving Northumbria University  Page 21
Further information  Page 22
Change the display fields

You may find it helpful to display additional field information in the EndNote library window.

1. Launch EndNote and open your EndNote library.
2. From the Edit menu choose Preferences.
3. Select Display Fields from the left-hand panel and make any amendments from the drop-down lists. For example, select Research Notes from the drop-down menu in column 10.
4. Click OK.
5. You will be returned to your EndNote library and as good practice you should check those column headings you have changed or added.

EndNote ratings

This allows you to rate the references added to your library and enables you to quickly identify key articles within your library. It is a personal feature based on your own opinion and has no relation to the star ratings given to Research Excellence Framework (REF) materials.

If you do not want to use this option right click the Rating bar in the reference window and remove the tick in the box next to Rating.

If you later decide this could be useful, right click on the reference bar where you want this to appear, tick next to Rating and it will reappear with any references previously rated.
Update references, already in your library, with additional online data

It can be useful to regularly update your references in case additional data is available to enhance the reference details. You can choose to update your entire library or individual records.

a) For individual records

1. Double click on the reference that you wish to update.

2. Click the Find Reference Updates… icon.

3. If the reference has any updates, the following box will appear with new information highlighted.

   You can choose to:
   a) Update All Fields – this will update every field that is highlighted. Be aware that this will overwrite anything you have previously input manually.
   b) Update Empty Fields – this will only add information where the fields are blank.
   c) Edit Reference – this allows you to manually update the fields you wish, discarding any other updates.

b) To update your entire library

1. Select all of the references in your library.
2. Click on References, then Find Reference Updates.
3. Choose one of the methods outlined above (3a, b, or c).
Add a keyword to multiple references

You can add keywords which will help you manage and identify these records. For example, you might want to add keywords to newly imported references which will help you identify those references again. You might find it useful to include your module code, search terms or date.

1. In the *My Library* pane click on *Imported References*.
2. From the *Tools* menu, choose *Change/Move/Copy Fields*.
3. From the *In:* drop-down menu choose *Keywords*.
4. In the text box, type in your keywords.
5. Click *OK*. In the next dialogue box click *OK* again to confirm the changes.
6. To check the references, scroll down to *Keywords* to make sure the text is correct.
7. Click *X* to return to *Imported References*.

Quick searches

1. Click in the *Quick Search* box on the menu bar at the top of the screen.
2. Input a search term, such as a title or keyword. **Note:** It is not necessary to put *and* between your keywords.
3. Press *Enter* and the words will be highlighted in yellow where they appear in the text.

Retrieve a library summary

This function provides information on:
- Library name and location.
- Date last saved.
- Number of Records, Groups, Reference Types, File attachments etc.
- Date last saved.

From the Tools menus choose *Library Summary*. 
Creating groups

It can be useful to organise references into groups if you have a large number of references or if you want to organise references to reflect, for example, chapters in your thesis, dissertation, by assignment, journal article.

a) Create a Group and add references to it

The Groups tools can help you manage your library more effectively. Creating groups and adding references to them means that you can easily move between different sets of references. For example, if you have just imported references from a particular database, you could create a group into which you move all those imported references. Alternatively, you can create a group and drag the selected references into it.

1. From the Groups menu, select Create Group.
2. Give the group a relevant name e.g. Cultural tourism.
3. Click on Imported References in the left-hand pane and click on the first title on the list.
4. Click on the Edit menu and choose Select all.
5. Press and hold down the left mouse button and drag the selected references to the Cultural tourism group.

Note:
- Deleting a reference from a custom group does not delete it from your library.
- Deleting a reference from a library also deletes it from all groups in that library. The reference no longer exists.
- One reference can be added to multiple custom groups.

b) Create a Smart group

This process is similar to creating a group but new references are added to the group automatically, based on search terms you define. For instance, you could create a smart group which searches your library for references where the Journal/Secondary Title is Travel Weekly. Not only will the search results be added to the smart group but all future references with this entry in the Journal/Secondary Title field will be added too.

1. Under the Groups menu, select Create Smart Group.
2. Choose a name for the smart group and enter this in the Smart Group Name box. In this example: Travel Articles.
3. Enter your search term(s). In this example we have chosen Journal/Secondary Title (from drop-down menu), Is (from the next drop-down menu) and Travel Weekly as the search term.
4. Click on the Create button.
5. The new smart group will display in My Groups in the My Library panel. Existing references which appear in Travel Weekly, for example, will now appear in the smart group Travel Articles and all future references imported into your library with this entry in the Journal/Secondary Title field will also be added.
c) Create a group set or combined groups

One way to further organise your references is to use group sets, often referred to as combined groups, which can include any of your groups or smart groups. To set up:

- Click on the Groups tab on the menu bar.
- Select Create Group Set.
- Type in a name for your new group, for example, Tourism, this will be listed in the My Library pane.
- To add any of your groups or smart groups simply drag these into the new group set or create new groups within this set.

**Note:** If you are using EndNote Online you can only create Groups, not Group sets or Smart Groups. Therefore, if you are syncing your desktop library with your online library only your Groups will display in the online version, although all of the references will display within All References.

### Recently added

The Recently Added function can be configured to show the references that have been added to the library over a set period of time.

Right click on Recently Added then choose from the list.

The references added during that specific period of time will be displayed.
Sharing an EndNote library with other people

You can now share your EndNote desktop library with up to 100 people. The owner of the main library and each invitee need to have an EndNote online account. The owner’s library must be fully synced before sharing, this can be checked by clicking on the Sync button on the toolbar.

To share an EndNote library

Click on the Share Library icon on the toolbar.

Type in the email addresses of the people you want to share your library with and click Invite.

Everyone on the list will receive an email inviting them to share the library. Their status will remain as Pending until they accept the invitation.

When the email has been received, click on the Accept button which will direct them to the EndNote sign-in page.

They will need to sign in with their own EndNote online account details. If they don’t already have an online account this can be set up now.

A message will confirm that the shared library can now be accessed using the Open Shared Library command from the File menu.

A list of libraries will display, select the correct one and it will open automatically.

The Activity Feed

Click on the Activity Feed icon on the toolbar and the latest activities will be displayed. If the feed item displays in dark grey this shows that there is more information available and this will display when the feed is selected.

All users can add, edit, delete and annotate references and any attached PDFs. All changes will be synced allowing users to view the changes.

To close the shared library click on the small x at the top of the page.

The owner of the library should make periodic back-ups of the library.
PDF attachments

a) Adding your own annotations

You can annotate PDFs stored in your library.

Highlight the reference you want to use and then click on the title of the PDF showing within the Reference pane. The PDF will be displayed, click on the Open PDF icon and the PDF will display in a new window.

To add notes click on the Sticky Note icon and double click at the point where you want to add the note. The Comments box will open and you can type in your notes.

To highlight, underline and strike-through, click on the relevant icon and select the text to be annotated.

b) View PDF annotations in a list

Once you have saved your annotations you can then view them as a list.

Right click on the PDF in the Reference pane and choose Open with Adobe Acrobat. Click on View, choose Comments then Annotations and a list will display on the right-hand side.
Bibliographies

Create a subject bibliography

A subject bibliography groups references around terms which appear in chosen fields in the library, such as the Keyword field. You might use this to create a reading list or handout.

1. Select Tools, Subject Bibliography.
2. Scroll down and select the Keywords field then click OK.

![Subject Fields](image)

3. You will see an index of terms that appear in the keyword field of the records in your library. Select the terms you would like to display as headings in the bibliography by clicking on each one. (In the example shown here, the keywords Cultural tourism have been chosen.)

![Subject Terms](image)

4. Click OK.

You will be shown a preview of the reference list. References will be ordered alphabetically under each of the terms you have chosen and can be edited by selecting a different style, editing the layout or choosing different terms.

![Subject Bibliography](image)

5. Click Save and give the file a name.
6. Click Save again, then Close.
Add a formatted list of references to a Word document

You can also use your EndNote library to add a bibliography or reference list to a Word document without creating citations.

1. Open your EndNote library.
2. Select the references you want to include (to select all references, click the Edit menu then Select all).
3. Click the Edit menu then Copy Formatted.
4. Open a new Word document and save it to your U: drive with your chosen filename.
5. Paste the references into your Word document by right clicking and choosing any of the Paste Options from the shortcut menu.
6. A formatted reference list will be added at the insertion point.

Alternative method

1. Highlight the references you want to insert into the word document.

2. Hold the Control button then click and drag the references down to the Word icon at the bottom of the screen and then up onto the page. When you release the Control button the references will be inserted into your document.

3. You can then reformat the references so they are consistent with the rest of your document.

NOTE: When references are added in this way they do not contain any links to EndNote so they can safely be deleted just as you would delete any other text in Word.

You cannot combine this type of reference list with a bibliography generated using Cite While You Write.
Cite While You Write – remove field codes

You should never directly edit EndNote citations within Word or attempt to directly edit an EndNote bibliography generated via Cite While You Write, because this could corrupt your document. You can edit citations in a Word document by clicking on the Edit and Manage Citation(s) button and making your changes via the resulting dialogue box.

If you need to directly edit the reference list, wait until you have finished working on your document. When you have no more citations to insert, create a new version of the document without field codes and edit this if necessary. To do this:

1. Place the cursor in the Word document but ensure it is not within an in-text citation or the bibliography section.
2. From the EndNote ribbon, select Convert Citations and Bibliography then Convert to Plain Text.

EndNote will create a new Word document with field codes removed leaving the original file unchanged (see dialogue box below). Click on OK.

3. A Word document will open with the EndNote field codes removed.
4. Edit the new document as necessary and save with a different filename.

Note: You should always remove field codes before submitting work electronically, i.e. via Blackboard or Turnitin.
Create your own customised style

You can create your own modified version of a referencing style using the instructions below. Follow each step in order.

1) Change folder locations

First create a folder to store your customised style file and make sure EndNote knows where to find it.

1. Click on the Start button and navigate to your U:drive.
2. Open the EndNote folder.
3. Create a new folder and call it Styles.
4. Once back in EndNote, select Edit, Preferences.
5. In the left hand pane select Folder Locations.
6. Check that the path to the Styles folder appears as below. If it is different, click on Select Folder in the styles folder section, navigate to the Styles folder on your U:drive and click Select, click Apply and then OK.
2) Edit style information

You are now ready to edit and modify a referencing style.

1. Select Edit, Output Styles, Open Style Manager.
2. Highlight the style you want to edit (for example Sage_Vancouver) and click on the Edit button.
3. Enter the name of your chosen style in the Based on box.
4. Enter appropriate comments in the Comments and limitations area as shown below.

![Style Manager Screenshot]

5. Select File, then Save as.
6. Enter the name of your new customised style (for example Sage_Vancouver modified) and then click Save.

3) Change format for anonymous works

Any reference with a blank Author field is considered to be an Anonymous Work by EndNote.

Settings available for this type of reference can be changed by selecting Anonymous Works from the left-hand panel and choosing the desired option via the radio buttons on the right, for example Use full title in place of author.

![Anonymous Works Setting Screenshot]
4) Differentiate ambiguous citations

With Author-Date styles, citations can be ambiguous where multiple works have been cited from the same author from the same year, or where there are several authors with the same surname.

EndNote offers a number of different options to differentiate between ambiguous citations, including outputting a letter after the year, for example (Brown, 2000a) and (Brown, 2000b). The letters appear in the citations and in the bibliography. Under Citations select Ambiguous Citations from the left hand panel and place a check in the box next to Add a letter after the year.

5) Change how multiple authors are output in repeat citations

You may want to change your style settings so that repeat citations use ‘et al.’ for four or more authors.

1. Under Citations in the left-hand pane click on Author Lists.
2. In the Abbreviated Author List – Subsequent Appearances change the number 3 to the number 4.

This option only applies to Author-Date bibliographic styles.
6) Use bibliography templates

Bibliography templates determine how references will be displayed in a bibliography. To view them click on Templates under Bibliography in the left-hand pane.

There are formatting templates for most reference types as well as a generic reference type template. Where a specific template does not exist for a reference type then EndNote will format using the generic reference template.

Templates can be edited by changing punctuation and by adding and/or removing fields.

To add fields;

a) Place the cursor at the point in the template where you wish to insert the new field.
b) Click the **Insert Field** button to display a list of field options.
c) Click on the required field and this will display in the relevant template.

7) Change the layout of the bibliography

Using this option, text can be set to be displayed either before or after a reference in the bibliography. For example, click on **Layout** then **Insert Field**. You can then select the required field.

**Hanging Indent:**
The bibliography can also be formatted so that the hanging indent is removed.
Click on the drop down arrow and choose **None**.

**Note:** Remember to save all the changes you have made.
Import references into EndNote from a text file

Some databases do not have an option to export directly into EndNote. Where this is the case you will have to:

i. Download the required references as a text file.
ii. Import the references into EndNote from the text file using a suitable filter.

To download references to a text file (using Zetoc as an example) go to the University Library Online:

1. Click on the A-Z databases.
2. Click on Z, then select Zetoc and log in.
3. Click on Zetoc Search – Access.
4. Click on Journal Search.
5. Type your search terms e.g. cultural tourism into the Article Title field and then click Search.
6. Scroll through the list, select the articles you want to save and click Download.
Make sure that the **Format** is set to **Short labels**, then click **Send file**.

![Download Records](image)

A dialogue box will appear, save the file onto your U drive.
To import the references into EndNote:

1. Open your EndNote library.
2. Click on **File**, **Import** then **File**.
3. Click on **Choose** and double click to select the text file saved earlier.
4. From the **Import Option** list box select **Other Filters**...
5. Highlight the **zetoc (MIMAS)** filter and click **Choose**.
6. Click on **Import**.

![Import File](image)

The references are added to your library, and also appear in the **Imported References** folder. It is recommended that you preview each reference to check the accuracy of the imported data and edit where necessary.

Click on **All References** to view your updated library.
Importing references into EndNote from a reading list

You can import references from your module reading lists into your EndNote desktop library.

1. Type your module code or keywords into the search box. Click Search.

To export the whole reading list:

2. Click on the drop-down arrow next to Export and select Export citations.

3. Click on the ris file that displays at the bottom of the screen.

EndNote will open automatically and the references will display in the Imported References window.

Since the reading list may contain the same references in various sections, you may find there are a number of duplicates which you will need to delete.

If you wish to import individual items click on the title of the resource then click Export citation.

EndNote will open automatically and the reference will display in the Imported References window.

Always check the references to make sure all the required details have been imported correctly.

Note: Only the reference details will be imported so will not include any file attachments such as PDFs.
Import references into EndNote from Google Scholar

If you use Google Scholar you can select single or multiple references from your results and export them into EndNote.

Click on the **Star** icon to save the references you wish to export.

Then click on **My library**.

Select the records to be exported, click on the **Export** icon and select **EndNote** from the drop-down menu.

Double click on the download box at the bottom of the screen and your references will automatically export into the Imported References window in your EndNote library.

Creating a compressed backup

It is good practice to create a backup copy of your library; especially important if you are making substantial customisation. To do this, open your EndNote library:

From the File menu select **Compressed Library (.enlx)**.

Select the specifications you wish to keep and then click **Next**.

Save the compressed file in a folder on your U: drive and change the name to something you will be familiar with.
Create an EndNote Online library

An EndNote online library can be created within your EndNote desktop library or within Web of Science™ Core Collection.

Register for EndNote Online via Web of Science

If you do not have an EndNote desktop account but study or work at Northumbria University you can use Web of Science to create an Endnote Online account.

To register:
In Library Search click on the A-Z databases link, click W and select Web of Science. Log in with your University ID and Password and tick you agree to the terms and conditions of use.

On the Web of Science homepage click on EndNote on the top menu bar. Click on Sign up to create your account.

Accessing EndNote online
To access your EndNote online account, go to http://my.endnote.com and enter your Web of Science username and password then click Sign in.

Link/sync your Endnote desktop with EndNote online and activate the sync process

In your EndNote desktop library click on the Sync icon on the Library toolbar to open the EndNote Login dialogue box.

Click on the Sign Up button to open a User Registration form.

Enter your email address; retype your email address, and then click Continue. Enter your personal information in the required fields on the next User Registration form.

Click the I Agree button to complete the registration process and to begin synchronizing your EndNote online library with your EndNote desktop library.
Sync Preferences allow you to set your preferences so that:

- You only have to enter your email address and password once in Sync Preferences and not each time you manually synchronize your references between EndNote desktop and EndNote online.
- You can have EndNote automatically begin the Sync process every 15 minutes (background processing) by selecting the **Sync Automatically** check box.
- To access **Sync Preference**, go to the **Edit** menu, select **Preferences**, and then click **Sync** in the list of preferences.

**Note:** The sync process updates all references added to either your online or desktop libraries and will update any changes to individual references. However only Groups will display in Endnote Online not Group sets, Smart Groups and Groups with combination Groups.

---

**Access an EndNote library on an iPad**

You can download an EndNote app to use on your mobile device and the EndNote Sync capability within the app enables you to synchronise your EndNote library across your desktop, iPad (mobile device) and online, to give you greater flexibility in how and where you access your research.

It is necessary to have an EndNote online account to run the iPad app and while you can do this from the iPad app this gives limited functionality. We recommend that you create your online account through Web of Science or your EndNote desktop library and you can then access, edit and manage your own library via the EndNote app.

User Guide and Online tutorials including:
- **EndNote on iPad: EndNoteSync, PDFs, and Groups** (2.50mins)
- **EndNote on iPad: The Browser and Downloads** (3.32mins)

---

**Set up and use EndNote on a Macintosh (Mac)**

For comprehensive guidance you can use Help in the EndNote program and to help you get started we recommend you take time to view the training videos.

- **How to use EndNote in 6 minutes**
- **Building an EndNote Macintosh Library: an EndNote Class Recording** (Duration Approx. 1.06 hours)

---

**Save your EndNote library before you leave Northumbria University**

There are three options, you can decide which is the best approach for you:

1. Register for an EndNote Basic [http://endnote.com/basic account](http://endnote.com/basic account). This gives you free access to a web version of EndNote – it doesn't have quite as many features as the desktop version but is still very usable. You can sync with your EndNote desktop library and so transfer all the content from the University account to this web account. The account remains active for 12 months, in this state, from the last time you logged in on a University PC or used off-campus authentication, it would be best to do this a couple of weeks before you leave, then it reverts to a slimmed down version of EndNote for a while longer, approximately 6 months, and then into a hibernating state.

2. You can save your complete library (the filename .enl file as well as its associated .data folder and all of its contents) to a single compressed filename.enlx file in order to easily back up your library or save a copy to access later. You can then easily restore (unzip) the compressed library with EndNote.
To save to a compressed library file follow the instructions in this guide **Creating a compressed back-up copy**.

To restore a compressed library file:

a) Use EndNote X8 to open the filename.enlx file, which will extract the .enl file and the .data folder to the same folder where the .enlx file is located.

b) Use EndNote X8 to open the filename.enl file as you normally would to use the library.

3. You can purchase a copy of EndNote If you are a registered student, researcher or member of staff, the University EndNote Site Licence entitles you to a discounted copy of EndNote for your personal use on MAC or Window devices. To purchase a copy go to [http://www.bilaney-consultants.co.uk/endnote-chest](http://www.bilaney-consultants.co.uk/endnote-chest)

**Note:** You must use your University email account to be eligible for a discounted copy.

---

**Further information about EndNote**

Note: This guide has been created using Google Chrome. If you are using a different browser, some of the options may look different.

There is comprehensive support available within EndNote.

- **EndNote Help:** Click on the Help icon in the EndNote program.

- The **EndNote Website** provides additional support, including Camtasia (screen capture demonstrations) for using EndNote: searching online databases, journal names, manual data entry, importing PDFs, and various Cite While You Write tutorials.

- The **EndNote User Forum** which is hosted by Thomson Reuters, a supplier of bibliographic software packages, including EndNote. Their website has information pages dedicated to EndNote.

Online resources are available to help you through **Develop your Learning Skills** available from the [University Library Online](https://myportal.northumbria.ac.uk)

- Under the topic **Referencing and Plagiarism** are a series of helpguides including the **EndNote Introduction** helpguide.

- **Short videos**, which are listed separately in **Skills Plus**, will guide you through the steps for changing a reference style, and how to import references from Library Search and an exemplar database.

If your query is not answered above please [contact us](mailto:ask4help@northumbria.ac.uk), and we can answer this directly or arrange an individual consultation to further advise you.